
 System Monitoring
• Displays codes as an aid in troubleshooting controller 

and indoor/outdoor unit operation
BASIC OPERATION

 If the unit is off, the screen displays the current time, 
indoor temperature, outdoor temperature, menu button 
(gear icon), power button and status icons (upper right). 
Touch the power button (lower right) to turn the unit on 
and display the last used operation mode screen.

 

 Swipe the screen to the left < to see the Main Operating 
Modes Screen. 

Main Operating Modes Screen

Displays buttons for controlling the following unit modes:
• AUTO - See page 2
• COOLING - See page 2
• HEATING - See page 2 
• DRY - See page 2
• FAN - See page 3

Touch a MODE button to switch the unit operation. The 
selected mode icon is displayed in the upper right side of 
the screen. 

 Swipe the screen back to the right > to see the current 
Operating Mode Screen. 

• TEMPERATURE UNIT SETTING (°F or °C)
 Touch the TEMPERATURE UNIT SETTING button to 

switch display between °F and °C.
 

• User Configuration Settings (Gear Icon) - See page 5
• Power (turns indoor unit On/Off)

NOTE - Refer to the Installation/Operation Instructions for 
additional information.

The V0STAT51 is a wired local touchscreen 
programmable controller for VRF Heat Recovery and Heat 
Pump indoor units.
Touchscreen Display
• 6-1/4 in. touchscreen with full color LCD display and 

intuitive navigation
• Screen is illuminated when touched and remains lit 

during control access

 Built-In Scheduling
• Offers the convenience of automatically changing 

settings according to a set time
• Schedules can be set for individual 7 days, 5+1+1 days, 

5+2 days or identical 7 days
• Custom holidays can be set to repeat for a particular 

year’s date or by a particular day of the week and month
• Up to eight different time period actions per day
• Schedules from one day can be copied to another

 Override Function
• During any schedule operation the system can be 

temporarily overridden (30, 60, 90, or 120 minutes)

 Battery
• One CR2032 lithium button battery is furnished as 

standard for memory retention

 Dimensions
• 5-1/2 x 7-1/4 x 1-3/8 in. (H x W x D)
• Additional hardware is furnished for installation

 Wiring
• Controller uses low voltage 4-wire 18AWG shielded cable 

(not furnished) for easy connection to the indoor unit

 Grouping
• Controller can control up to 16 indoor units on the same 

system in the same room
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BASIC OPERATION (continued)
Cooling Operation Mode Screen

Displays buttons for controlling unit during cooling mode:
• Cooling Setpoint Button on the round temperature band 

(adjustable 62 to 86°F)
Setpoint range limits are adjustable in Service Menu>  

Setpoint Limit (see page 7).
 
• Cooling Setpoint Display (Cool To)
• Space Temperature Display
• Space Relative Humidity (RH%) Display
• Common Control Buttons (Fan, Swing Schedule, 

Override) - See page 3
Touch and slide the blue cool setpoint indicator on the 

round temperature band to change the cooling setpoint 
in one degree increments. 

Heating Operation Mode Screen

Displays buttons for controlling unit during heating mode:
• Heating Setpoint Button on the round temperature band 

(adjustable 62 to 86°F)
Setpoint range limits are adjustable in Service Menu>  

Setpoint Limit (see page 7).
 
• Heating Setpoint Display (Heat To)
• Space Temperature Display
• Space Relative Humidity (RH%) Display
• Common Control Buttons (Fan, Swing Schedule, 

Override) - See page 3
Touch and slide the red heat setpoint indicator on the 

round temperature band to change the heating setpoint 
in one degree increments. 

Auto Operation Mode Screen

Displays buttons for controlling unit during cooling and 
heating mode:
• Cooling/Heating Setpoint Buttons on the round 

temperature band (adjustable)
• Cooling - 65 to 86°F
• Heating - 62°F to 83°F

Setpoint range limits are adjustable in Service Menu>  
Setpoint Limit (see page 7).

• Cooling/Heating Setpoint Display (Cool To and Heat To)
• Space Temperature Display
• Space Relative Humidity (RH%) Display
• Common Control Buttons (Fan, Swing Schedule, 

Override) - See page 3
Touch and slide the red or blue setpoint indicators on the 

round temperature band to change the heating/cooling 
setpoints in one degree increments. 

If the system is operating in Auto Mode, both heating 
and cooling setpoints are displayed. The larger display 
indicates the active mode. 

Dry Operation Mode Screen

Displays unit operation in dry (dehumidification) mode:
• Dehumidification Setting on the round temperature band
• Space Temperature Display
• Space Relative Humidity (RH%) Display
• Common Control Buttons (Fan, Swing Schedule, 

Override) - See page 3
Touch and slide the blue setpoint indicator on the round 

temperature band to change the setpoint in one degree 
increments. 

Fan speed is disabled when system is in DRY 
(dehumidification) Mode.
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BASIC OPERATION (continued)
Fan Only Operation Mode Screen

Displays unit operation in fan only mode.
Common Control Buttons (on all MODE screens)

Fan Control
• Auto
• High
• Medium
• Low

Selected fan speed icon is animated when unit is 
operating.

 
Vertical Swing Angle Button
• Swing Function
• Five Individual Positions

Horizontal Swing Position Button
• Swing
• Stop

Swing buttons enable automatic louver swing function on 
certain indoor units.

 
Schedule Button
• Touch to access the Schedule screen (see Schedule 

Screen)

Activate Override Button
•  Temporarily override system operation in 30, 60, 90, or 

120 minute increments
 Individual override time period settings can be enabled/

disabled on the Schedule Screen (see page 5).
 

Override function is only available if a schedule has been 
set.

 
Space temperature is sensed by the internal sensor in the 

controller (default) or by the indoor unit sensor.
Sensor location can be set on the Service Menu > Room 

Temperature Sensor Screen (see page 7).

 

USER SETTINGS
Schedule Screen

A Schedule Template contains Schedule Actions which 
are then added to a weekly Schedule Setup.
See the User/Service Settings table on page 5 for 
additional information.

Schedule Templates
Create a blank schedule template
• Add Button

Up to ten different Schedule Templates can be created.
 
Schedule Actions
Create actions to add to a schedule template:
• Add Button
• Save Button
• Start (Start Time)
• On-Off (System Operation)
• Mode (Cool, Heat or Auto)
• Cool Setpoint (62 to 86°F)
• Heat Setpoint (62 to 86°F)
• Fan Speed (Low, Medium, High or Auto)
• Occupancy (Active/Inactive)

Up to eight different Schedule Actions can be created.
 
Schedule Setup
 Add Schedule Templates (containing Actions) to a weekly 
schedule:
• Everyday (set individual schedules for days of the week)
•  5+1+1 Days (set same schedule for Mon-Fri and 

separate schedules for Sat-Sun)
•  5+2 Days (set same schedule for Mon-Fri and same 

schedule for Sat-Sun)
• 7 Days (set same schedule for all seven days)



V0STAT51P-3 Programmable Wired Controller / Page 4

USER SETTINGS (continued)
Holiday and Special Day Schedule Screen

 Add Schedule Templates (containing Actions) to a holiday 
or special day schedule:
• Add Button
• Day
• Date
• Day of Month
• Date Range

Holiday schedules can be set by a particular year’s date or 
a repeating day of the year (example: every 3rd Thursday 
in November). 
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USER /  SERVICE SETTINGS
MENU SETTING (default is bold) Notes:

HOME >>

GENERAL > Use 24 Hour Format > Off Slide button enabled.
On

Date and TIme > set date and time Input the date and time using the set 
date and set time tools.

Theme > Dark Change the background on the main 
screens.Colorful

Simple
Brightness > 10 to 100% Adjust brightness using the slide control.
Controller Touch 
Tone >

On Slide button enabled.
Off

Screen Saver > Blank Drop-Down Menu.
Load custom image using USB drive 
(800 x 400 PNG).

System Information
Custom Image

Screen Saver Delay > 30, 60, 90 seconds or light Use slide control to adjust delay time.
SWING > Vertical > Swing, position 1, 2, 3 ,4 or 5 Use slide control to set swing operation.

Horizontal > Swing Slide button enabled.
Stop

SCHEDULE > Override Options > 30, 60, 90, 120 minutes, clear button Only available if a schedule has been set.
Schedule Templates > Add Schedule Template Button Create up to 10 schedule templates. 

Swipe left to delete or rename template. 
Touch and hold to copy template.

Add Action > Add Action Button to Schedule Template Create up to 8 actions for each 
schedule template. 
Swipe left to delete or rename action. 
Input time using the set time tool.
NOTE - Fan speed disabled when 
system is in DRY (dehumidification) 
Mode.
NOTE - Depending on selection some 
modes are grayed out if Auto Mode is 
not selected.

Time
On/Off
Mode (Auto, Cool, Heat, Dry, Fan)
Cool Temp (62 to 86°F)
Heat Temp (62 to 83°F)
Fan (Low, Med, High, Auto)
Occupancy (Active, Inactive)

Schedule Setup > Add Weekly Schedule Button Add a schedule template containing 
actions to a weekly schedule.Every Day

5+2 Days
5+1+1 Days
Individual 7 Days

Holiday/Special Day 
Schedule >

Add Holiday Schedule Button  Add Schedule templates containing 
Actions to a holiday or special day 
schedule.
NOTE - Holiday schedules override 
normal schedules on the days set.

Day
Date
Day of Month
Date Range
Select Termplate to use

DAYLIGHT 
SAVINGS TIME >

Daylight Savings Time 
>

On Slide button enabled.
Off
Start Date Input the date and time using the set 

date and set time tools.End Date
ROOM 
TEMPERATURE & 
RH% >

Temperature Unit > °F Slide button enabled.
°C

Display Space 
Temperature on 
Homepage >

On Slide button enabled.
Off

Display RH on 
Homepage >

On Slide button enabled.
Off
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USER /  SERVICE SETTINGS
MENU SETTING (default is bold) Notes:

HOME >>

ADVANCED 
INFORMATION >

Operation Data > ODU Priority (Auto/Cool/Heat/VIP/Heat 
Only/Cool Only)

View information about the system.

ODU Mode (Cool/Heat/Fan/Force Cool/
OFF)
Master IDU
Number of Indoor Units Connected
Indoor Unit Address
Series (indoor unit type)
Capacity
Mode
Cooling Setpoint
Heating Setpoint
T1 - In Use (indoor temp used by system)
T1 - IDU (Indoor unit sensor)
T2 (evaporator middle temperature)
T2A (evaporator inlet temperature)
T2B (evaporator outlet temperature)
EXV (expansion valve open position)
Fan Speed
Software Version

Error Code > No. (serial number) View the error code history for each 
outdoor unit connected to the controller.IDU#

Error (error code number)
Type (IDU, ODU, CTRL)
Date and Time
Clear History Button

Error Code Description Button
HHE Interface > Number of Indoor Units Connected Access the HHE relay query interface.

Indoor Unit Address
FAN (inactive)
CTON (inactive)
HTON (inactive)
AUXH (inactive)
DEHU (inactive)
Dry Contacts (Reserved) (inactive)

Controller > Controller Model Number View information about the Controller.
Controller Software Version
Group No.
Space Temp.
Space RH%

Contractor 
Information >

Name Use the keyboard tool to manually input 
Contractor information.Company name

Address
Phone Number
Email Address
Web Site

Help > Home Page Instruction Graphic
Error Code List
CPU Information
Memory Information
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USER /  SERVICE SETTINGS
MENU SETTING (default is bold) Notes:

HOME >>

SERVICE MENU >
NOTE - Use keypad 
number tool to enter 
password and enter 
the Service Menu 
Screen (default is 
0000).
Password can be 
changed on the 
Service Menu 
screen.

Master/Sub > Master Select if the Controller is the Master 
Controller or Sub-Controller.Sub

Indoor Unit 
Addressing >

#0 to 63 Set indoor unit address. Only available 
for connected single indoor unit

Indoor Unit Display 
Board >

Display Board - On/Off Slide button enabled. 
Digital display shows setpoint 
temperature. 
Indoor unit beeps when setting chnage.

Buzzer - On/Off

Room Temperatue 
Sensor >

Sensitive (1°F or 2°F,)
Calibration (-5°F to 5°F (0°F)

Location > Controller
Individual Indoor Unit
Select One of the Indoor Units

Auto Mode > Auto Mode Changeover (15, 30, 60 90 
minutes)
Setpoint Deadband (3, 4, 5,6 ,7°F)

Draft Prevention > 59, 68, 75, 79°F When the evaporator temperature (T2 
Sensor) is lower than the set value in 
heating mode the indoor unit fan will 
stop to prevent supplying cold air.

Indoor Fan Settings > Cool (off-low-medium-high-maintain) Use the slide control to set indoor unit 
fan operation when setpoint is satisfied.Heat (off-low-medium-high-maintain)

Static Pressure > 0 to 1.0 in. w.g. (0 in. w.g.) In increments of 0.04.
Occupancy Sensor > On/Off Slide button enabled.

Delay (0, 15, 30, 60 minutes) Use slide control to adjust.
Unoccupied Setpoint Offset (0, 2, 4, 6, 8°F)
Heating Setback (54, 62, 70°F) Drop-Down Menu.

Humidity Sensor > Auto Dry (On/Off) Slide button enabled.
Dehumidifier Contact (On/Off)
Target RH% (0 to 100%, 50%) Use slide control to adjust.
Cutoff (On/Off) Slide button enabled.
3, 4, 5°F Use slide control to adjust.

Aux/AH. Heat 
Contact >

No Auxiliary/Alternative Heat Installed
Aux/Alt Heat Installed at IDU or in Duct
Other Aux/Alt Heat Installation
Heat On (2, 3, 4, 5, 6, 7°F)
Heat Off (-4 to 4°F, 1°F)

Setpoint Limit > Minimum Cooling Setpoint (62 to 86°F)
Minimum Heating Setpoint (62 to 86°F)

Lock > Lock (OFF/ON) Use slide control to adjust.
Mode (OFF/ON)
Temperature Setpoint (OFF/ON)
Schedule (OFF/ON)
Horizontal Louver (OFF/ON)
Vertical Louver (OFF/ON)

Firmware and 
Setting >

Controller Firmware Update button Requires USB drive.
Indoor Unit Firmware Update button
Backup Setting
Import Setting
Reset Setting Reset to factory defauls.
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SPECIAL STATUS SYMBOL DISPLAYS (Located on Upper-Right Mode Screens)
Icon Name Description

Fan Displays when the indoor unit is in Fan mode.

Cool Displays when the indoor unit is in Cooling mode.

Heat Displays when the indoor unit is in Heating mode.

Dry Displays when the indoor unit is in Dry mode.

Cooling operation in Auto 
mode Displays when the indoor unit is in Auto mode providing cooling operation.

Heating operation in Auto 
mode Displays when the indoor unit is in Auto mode providing heating operation.

Centralized controller lock Displays when some functionality is locked by a centralized controller.

Group control Displays when more than one indoor unit is connected to the controller.

Occupancy sensor Displays when an occupancy sensor is active.

Help Tap to see the Help screens.

Mode conflict prompt Displays when the indoor unit is in mode conflict with the outdoor unit (heat pump systems)

Auto Dry function Displays when auto dry function is ON.

Master controller Displays if the controller is a master.

Sub controller Displays if the controller is a sub.

Outside air ducted indoor unit Displays if the connected indoor unit is providing outside air.

ON/OFF lock Displays when some functionality is locked by settings on this controller.

Mode lock Displays when Mode is locked.

Setpoint lock Displays when Setpoint is locked.

Schedule lock Displays when Schedule is locked.

Defrosting or oil return Displays when the outdoor unit is in defrost or oil return operation.

Cold air prevention Displays during period of time before the coil warms to the determined cold air prevention 
temperature. The fan will not run during this time period.









NOTE - Due to Lennox’ ongoing commitment to quality, Specifications, Ratings and Dimensions subject to change without notice and without incurring liability. 
Improper installation, adjustment, alteration, service or maintenance can cause property damage or personal injury. 
Installation and service must be performed by a qualified installer and servicing agency. ©2020 Lennox Industries, Inc. 

Visit us at www.lennox.com 
For the latest technical information, www.lennoxcommercial.com 
Contact us at 1-800-4-LENNOX
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